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1
 Copyright Notices

Copyright©2020 – Expert4x, all rights reserved. This eBook is intended for the purchaser’s personal use only.
No part of this eBook may be reproduced or transmitted in any form whatsoever, electronic, or mechanical,
including photocopying, recording, or by any informational storage or retrieval system without expressed written
permission from Expert4x.

Copyright©2020 EAfactory, all rights reserved. All title, including but not limited to copyrights, in and to the
GridTrendMultiplier EA and any copies thereof are owned by EAfactory or its suppliers. All title and intellectual
property rights in and to the content which may be accessed through use of the GridTrendMultiplier EA is the
property of the respective content owner and may be protected by applicable copyright or other intellectual
property laws and treaties. All rights not expressly granted are reserved by EAfactory. For the full details please
refer to the End-User License Agreement ("EULA")
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2
 Getting Started with the GridTrendMultiplier EA

Getting Started provides a guided exploration of the GTM EA. It is geared for an audience that has little or no
knowledge of installing an MT5 EA. It walks the novice user through downloading and installing the GTM EA.

2.1 Installing the GridTrendMultiplier EA
The GTM EA comes with a setup application to provide a wizard based installation process to the selected MT5
terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT5 terminal version 5.00 build 2530 or later installed.

1. Exit MT5 if it was running.

2. Log in to the Web Support Centre.

3. Scroll down and click on the GridTrendMultiplier EA in the Product List.

4. Click on the Product Download button to download the EA setup.

https://my.eafactory.com/expert4x
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5. Run the setup application. Select the MT5 instance during setup to where you want the service installed.

6. When setup completes start up MT5. The GTM EA entry should appear under the Expert Advisors node in
the Navigator window (View > Navigator)

These pictures highlight the steps how to install the ea.

The setup application lists the available MT5 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT5 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.
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C:\Program Files\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader installation. As a hint, the following
shows you the default path to the main MT5 directory for some brokers:

Broker Default Path

Blueberry Markets broker C:\Program Files\Blueberry Markets MT5 Terminal

ICMarkets broker C:\Program Files\ICMarkets - MetaTrader 5

ActivTrades broker C:\Program Files\MetaTrader 5 - ActivTrades

Admiral Markets broker C:\Program Files\Admiral Markets MT5

Pepperstone broker C:\Program Files\Pepperstone MetaTrader 5

Always select the main MT5 folder itself for installation target, not any of its sub-directories.

When the installation is complete, start up MT5 and check that the ea appears in the Navigator window (View >
Navigator):
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So everything is set up for the first activation of the GridTrendMultiplier Expert Advisor  .

2.2 GridTrendMultiplier Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the GridTrendMultiplier Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the GridTrendMultiplier Expert Advisor  from the Navigator window (View > Navigator)
to a chart window. In the appearing properties window select the Dependencies tab and tick the checkbox
Allow DLL imports:
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2. Go to the Common tab and tick the checkbox Allow Algo Trading:

Note:

Ensure that the

• Allow DLL imports and
• Allow Automated Trading

are ticked otherwise the GridTrendMultiplier EA is not able to start up.

3. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the GridTrendMultiplier EA can be
set up. For more details see the GridTrendMultiplier EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The GridTrendMultiplier EA is up and running

After successful authentication the GridTrendMultiplier EA starts up.

https://my.eafactory.com/expert4x
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The GridTrendMultiplier Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the GridTrendMultiplier Expert Advisor  was successful and the EA is now
looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the ea up and running please refer to the Knowledgebase section.
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3
 System Requirements

3.1 Operating System Requirements
In order to operate the GridTrendMultiplier EA a Microsoft Windows operating system is required which
supports MetaQuotes MetaTrader version 5.00 platform.

Note that the MetaQuotes MetaTrader software is also known and often referred to as MT5.

3.2 Hardware Requirements
The minimum Random Access Memory (RAM) requirement is 512MB (0.5GB), however 1024MB (1GB) RAM
is recommended to avoid extended virtual memory usage. Note that this memory requirement is for MetaTrader
application only, excluding other applications running at the same time (e.g. MS Office). If other applications are
running parallel with MetaTrader application please increase the RAM requirement accordingly.

3.3 MetaTrader (MT5) Requirements and Settings
The EA is compatible with MetaQuotes MetaTrader platform version 5.00 build 2530 or higher. In general this is
referred to as MT5 terminal, build 2530 or newer.

3.4 Forex Broker Requirements
The GridTrendMultiplier EA is compatible with both 4 and 5-digit data feeds based brokers. The
GridTrendMultiplier EA automatically detects the type of the feed and adjusts the EA parameter pip values if and
when necessary.

Both fixed and variable spread broker platforms are supported.

The broker account must support retail hedging mode in order for the EA to operate. Note that the netting mode
broker account is not compatible with the EA.

The selected MetaTrader based broker should allow keeping open orders on the account for long period of time,
i.e. the broker should not close and re-open orders over night for swap calculation, or should not merge open
orders for any reason.

IMPORTANT: For smooth trade management the MetaTrader application and the EA should be on-line, up and
running during all market open hours (usually Sunday to Friday).

3.5 Hedging Support Requirements
The broker account must support retail hedging mode in order for the EA to operate. Note that the netting mode
broker account is not compatible with the EA.
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3.6 FIFO Support
By default the GridTrendMultiplier EA may open and close positions out of order of the First-In-First-Out (FIFO)
sequence. If your broker does not allow for this and requires to comply with the FIFO rule then please ensure that
you select the Apply FIFO Adjustments value for the EA parameter Lot Adjustment for FIFO.

Important:  On broker accounts mandating the FIFO this configuration option must be set before the first start
of the EA. Late re-configuration of this option may result in FIFO related trading issues. In this case the only
resolution could be to close off all the trades of the ongoing grid and start a new grid from scratch.

3.7 Account Type and Minimum Lot Size Requirements
The broker account must support retail hedging mode in order for the EA to operate. Note that the netting mode
broker account is not compatible with the EA.

A so-called Micro broker account is necessary if the available funds for the EA trading is less than approx. $1000.
The micro account allows the EA to open a position with minimum lot size of 0.01. If you plan to use a broker
account with the above funding please ensure that your broker account offers this minimum lot size.

An easy way to double check the minimum lot size available on the broker account is to attach the EA to a chart
and check the Market Info section on the chart:

The Lot line shows Min:0.01 which tells that the minimum lot size requirement is 0.01 on this broker account.

3.8 ECN/STP Broker Accounts
Many brokers offer Electronic Communications Network (ECN) or Straight Through Processing (STP) accounts.
Common behaviour for these accounts is the variable spread and market orders where no initial stop loss and take
profit targets can be specified. In this case the market order must be submitted with no SL and TP values, and
these values are to be set in the second step using an additional order to the opened ticket.

The GridTrendMultiplier EA is compatible with the above ECN/STP broker accounts and needs no additional
settings to operate on them.
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4
 GridTrendMultiplier EA Configuration Guide

The GridTrendMultiplier EA configuration guide.

In order to activate the GridTrendMultiplier EA attach it to a chart window – for more details see
GridTrendMultiplier EA First Time Activation section.

4.1 Configuration and Operation Principles
The GridTrendMultiplier EA operational overview.

The GridTrendMultiplier EA manages only those tickets (a.k.a positions) on the account which belong to the
GridTrendMultiplier EA: every order submitted to the account is marked with the MagicNumber and, in return,
only those tickets on the account will be considered by the GridTrendMultiplier EA which are marked with this
MagicNumber.

In general it is recommended to run on an account one EA at a time. This helps understanding the ongoing trades
and troubleshoot situation if and when needed.

While this maybe feasible for demo accounts this may not be feasible for live accounts where there could be the
need to execute multiple expert advisors on the same account at the same time.

Using multiple expert advisors on the same account is only viable if each and all expert advisor will follow the
above MagicNumber principle and they manage only their own tickets on the account.

IMPORTANT: If you plan to use multiple expert advisors (other than the GridTrendMultiplier EA) on the
same account please ensure upfront with the expert advisor providers that their EA's are suitable for that
as per the above.

If you plan to use multiple GridTrendMultiplier EA's on the same account at the same time please ensure that the
MagicNumber is set to different and unique number for each chart of the same market.

Here are few examples:

Market MagicNumber

EURUSD chart 1 5000

EURUSD chart 2 5001

EURUSD chart 3 5002

GBPUSD chart 1 5010

GBPUSD chart 2 5011

GBPUSD chart 3 5012

USDCAD single chart EA default or any other

USDCHF single chart EA default or any other

4.2 GridTrendMultiplier EA Parameter Descriptions
The GridTrendMultiplier EA parameter descriptions.
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4.2.1 Trading vs Planning Mode

 Startup & Operation Mode

Startup & Operation Mode

Selects the desired level of trading available when the Forecast Tool is used for planning and analysis. If one
wants to analyze a new market which does not have an ongoing grid then the Planning Mode Only allows to use
the Forecast Tool on that market without entering any actual trades.

Startup & Operation
Mode

Description

Grid Trading & Planning
Mode

The EA performs start of new grids and grid trades as normal according to its
configuration. On top of the running grid trades the Forecast Tool is available
to visualize the impact of future price point. The Forecast Tool takes into
consideration the starting point of the existing buy and sell grids and their open
positions.

Planning Mode Only (No
New Trade Entries)

The EA does not enter any new trades, nor exit any existing grid trades in this
mode. The Forecast Tools is available for planning and analysis purposes while no
trading is performed. If there were any existing grid trades on the pair of the chart
then those are considered by the Forecast Tool.
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4.2.2 Combined Profit & Risk Settings

 Closure at Profit Level
 Target Profit Amount

Target Profit Amount

Combined buy and sell profit target as an amount of balance increase by the EA trades. The EA will keep trading
the buy and sell grids, cash-in at grid levels, until the overall profit of cashed-in and floating buy and sell trades
reaches the value of Target Profit Amount. When this combined target is reached then all open buy and sell trades
get closed off and (if Reentry After Grid Closure is set to Enabled) a new cycle of grid trades is started off.

Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Target Profit Amount is set to 100

The EA trades buy and sell grids until the sum of the closed and floating tickets' profit reaches 100.
 Target Profit Percent

Target Profit Percent

Combined buy and sell profit target as a percentage of balance increase by the EA trades. The EA will keep
trading the buy and sell grids, cash-in at grid levels, until the overall profit of cashed-in and floating buy and sell
trades reaches the percent growth of account balance. When this combined target is reached then all open buy and
sell trades get closed off and (if Reentry After Grid Closure is set to Enabled) a new cycle of grid trades is started
off.
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Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Target Profit Percent is set to 2
• Account balance is 5000

The EA trades buy and sell grids until the sum of the closed and floating tickets' profit reaches 5000 x 2% = 100.
 Target Profit Pips

Target Profit Pips

Combined buy and sell profit target in pips by the EA trades. The EA will keep trading the buy and sell grids,
cash-in at grid levels, until the overall profit of cashed-in and floating buy and sell trades reaches this number of
pips. When this combined target is reached then all open buy and sell trades get closed off and (if Reentry After
Grid Closure is set to Enabled) a new cycle of grid trades is started off.

Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Target Profit Pips is set to 100

The EA trades buy and sell grids until the sum of the closed and floating tickets' profit reaches 100 pips.

Note:  In the case of 5-digit data feed (a.k.a fractional pips) 1 pips is equal to 10 points. The EA expects this input
in pips, not in points.

 Closure at Loss Level
 Max Loss Amount

Max Loss Amount

Combined buy and sell maximum loss as an amount of balance decrease by the EA trades. The EA will keep
trading the buy and sell grids, cash-in at grid levels, until the overall loss of cashed-in and floating buy and sell
trades reaches the value of Max Loss Amount. When this combined loss is reached then all open buy and sell
trades get closed off and (if Reentry After Grid Closure is set to Enabled) a new cycle of grid trades is started off.

Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Max Loss Amount is set to 100

The EA trades buy and sell grids until the sum of the closed and floating tickets' loss reaches 100.
 Max Loss Percent

Max Loss Percent

Combined buy and sell maximum loss as a percentage of balance decrease by the EA trades. The EA will keep
trading the buy and sell grids, cash-in at grid levels, until the overall loss of cashed-in and floating buy and sell
trades reaches the percent drop of account balance. When this combined loss is reached then all open buy and sell
trades get closed off and (if Reentry After Grid Closure is set to Enabled) a new cycle of grid trades is started off.

Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Max Loss Percent is set to 2
• Account balance is 5000

The EA trades buy and sell grids until the sum of the closed and floating tickets' loss reaches 5000 x 2% = 100.
 Max Loss Pips
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Max Loss Pips

combined buy and sell maximum loss in pips by the EA trades. The EA will keep trading the buy and sell grids,
cash-in at grid levels, until the overall loss of cashed-in and floating buy and sell trades reaches this number of
pips. When this combined loss is reached then all open buy and sell trades get closed off and (if Reentry After
Grid Closure is set to Enabled) a new cycle of grid trades is started off.

Note:  This feature can be configured in combination of any other grid exit trigger at the Combined Profit & Risk
Settings section. The EA will track each of them independently and will trigger the close-out when any one of the
exit conditions is fulfilled.

Example:

• Max Loss Pips is set to 100

The EA trades buy and sell grids until the sum of the closed and floating tickets' loss reaches 100 pips.

Note:  In the case of 5-digit data feed (a.k.a fractional pips) 1 pips is equal to 10 points. The EA expects this input
in pips, not in points.

 Closure at Price Level
 Close Grid On or Above Price

Close Grid On or Above Price

The upper price limit for running the grid. When the actual price reaches or goes above this level the EA closes
off all open grid trades, regardless of the overall grid profit and loss value. After the grid closure the EA does not
start up a new grid even if the price goes back below this Close Grid On or Above Price.

Note:  After a grid closeout due to reaching this limit, the EA remembers not to start up a new grid. However, if
the EA (or the MT4 terminal) gets restarted the EA will no longer remember the closeout and may start up a new
grid if the price is below this limit.

When this Close Grid On or Above Price is configured with a price value then the EA automatically disables the
Reentry After Grid Closure feature.

Note:  This feature can be configured in combination with any other grid exit trigger at the Combined Profit &
Risk Settings section. The EA will track each of them independently and will trigger the close-out when any one
of the exit conditions is fulfilled.

Examples:

• Close Grid On or Above Price is set to 0

There is no upper price limit to running the grid trades, i.e. this feature is turned off.
• Close Grid On or Above Price is set to 1.2345

The EA trades buy and sell grids until the actual price reaches, or is above, the 1.2345 value. When the
1.2345 is reached the EA closes off all open grid trades and no new grid is started off (until after the EA
gets restarted).

 Close Grid On or Below Price

Close Grid On or Below Price

The lower price limit for running the grid. When the actual price reaches or goes below this level the EA closes
off all open grid trades, regardless of the overall grid profit and loss value. After the grid closure the EA does not
start up a new grid even if the price goes back above this Close Grid On or Below Price.

Note:  After a grid closeout due to reaching this limit, the EA remembers not to start up a new grid. However, if
the EA (or the MT4 terminal) gets restarted the EA will no longer remember the closeout and may start up a new
grid if the price is above this limit.

When this Close Grid On or Below Price is configured with a price value then the EA automatically disables the
Reentry After Grid Closure feature.

Note:  This feature can be configured in combination with any other grid exit trigger at the Combined Profit &
Risk Settings section. The EA will track each of them independently and will trigger the close-out when any one
of the exit conditions is fulfilled.

Examples:
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• Close Grid On or Below Price is set to 0

There is no lower price limit to running the grid trades, i.e. this feature is turned off.
• Close Grid On or Below Price is set to 1.2345

The EA trades buy and sell grids until the actual price reaches, or is below, the 1.2345 value. When the
1.2345 is reached the EA closes off all open grid trades and no new grid is started off (until after the EA
gets restarted).

 Closure by Optimum Restart
 Optimum Restart Minimum Ticket Count

Optimum Restart Minimum Ticket Count

A long running grid may develop over time distant buy and sell open trades. It could be beneficial to close off the
ongoing grid at an optimum price point to allow for a new grid. The optimum price point would be somewhere
between the open buys and sells, depending on their overall lot sizes. This parameter allows the EA to close off
the ongoing grid if the number of open buy and sell positions together reached this minimum count value while
the buy side and the sell side losses are at about the same amount.

Example:

• Optimum Restart Minimum Ticket Count is set to 10

The EA trades buy and sell grids and the total number of open buy and sell trades reaches 10. From that point on
the EA monitors the amount of losses of the open trades on the buy side as well as on the sell side, independently
from each other. Once the buy side floating losses and the sell side floating losses become similar then the EA
closes off all the open trades, on both the buy and the sell side.

Attention:  It may take some time before the buy side and the sell side loss amounts would become similar and the grid closeout gets triggered. In the meanwhile the EA carries on with normal grid trading as usual, entering and cashing-in grid trades. Because of this the actual number of open buy and sell trades could go beyond the Optimum Restart Minimum Ticket Count.

 Balance of Buy & Sell Grid Trades
 Max Gap of Buy vs Sell Open Trades

Max Gap of Buy vs Sell Open Trades

Keeps the difference between the number of open trades on the buy and sell side within a limit. This parameter
sets the maximum gap allowed as a difference before one of the resolution actions applied, as selected at the Max
Gap Resolution.

 Max Gap Resolution

Max Gap Resolution

The type of action to be performed when the maximum gap between the open buy and sell trades is breached.

Max Gap Resolution Description

Trade With Trend Only The EA allows for new trade only in that direction which has the less number of
open grid trades. By enlarge this means that the new trades will be entered in the
direction of a prevailing trend.

Prune Highest Loss Trade The EA allows for new trade in any direction, but also closes off the previous open
trade with the highest loss amount in the direction with the higher number of open
trades when the max gap is breached.

Examples:

• Max Gap of Buy vs Sell Open Trades is set to 6
• Max Gap Resolution is set to Trade With Trend Only
• There are more open buy trades in place than open sell trades.
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The EA trades buy and sell grids until the gap between the number of open buy and sell trades reaches 6. Because
there are more open buy trades than sell trades, only an upcoming new sell trade entry is considered and will be
performed, but no upcoming buy trade is considered. In a falling market this will allow for sell trades but not for
buy trades.

• Max Gap of Buy vs Sell Open Trades is set to 6
• Max Gap Resolution is set to Prune Highest Loss Trade
• There are more open buy trades in place than open sell trades.

The EA trades buy and sell grids and the gap between the number of open buy and sell trades exceeds 6. Because
there are more open buy trades than sell trades, the EA identifies the open buy trade with the highest amount of
loss and closes it off.

 Position Sizing
 Equity Amount Reserved for This EA

Equity Amount Reserved for This EA

The amount of money allocated for this EA for trading purposes. This reserved amount should be less than the
account equity. Also, when multiple EAs are running on the account, their total reserved amounts should be less
than the account equity.

Example: I want the EA to trade $2000 part or share of the account equity.

Here is an EA configuration to achieve the above:

 1. Equity Amount Reserved for This EA = 2000
 Maximum Drawdown Allowed

Maximum Drawdown Allowed

The drawdown level, as a percentage of the Equity Amount Reserved for This EA, when the EA should stop
further trading.

Example: I want the EA to trade $2000 part of the account equity and stop trading when the drawdown becomes
30% or more of this $2000.

Here is an EA configuration to achieve the above:

 1. Equity Amount Reserved for This EA = 2000
 2. Maximum Drawdown Allowed = 30

 Position Sizing Method

Position Sizing Method

The position sizing mechanism used for new trades at grid level entry.
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Position
Sizing Method

Description

Percent of Account
Free Margin

The lots for new position is calculated based on

• Free Margin available on account, and
• Position Risk Percent, and
• BUY/SELL Gap Size, and
• Max Open Ticket Count

The lots for the new position is calculated the following way:

 1. Composite SL is determined as: BUY/SELL Gap Size x Max Open Ticket Count
 2. Risk amount is determined as: Position Risk Percent of Free Margin
 3. Lots determined as: Composite SL / Risk Amount

Percent of Account
Equity

The lots for new position is calculated based on

• Equity available on account, and
• Position Risk Percent, and
• BUY/SELL Gap Size, and
• Max Open Ticket Count

The lots for the new position is calculated the following way:

 1. Composite SL is determined as: BUY/SELL Gap Size x Max Open Ticket Count
 2. Risk amount is determined as: Position Risk Percent of Equity
 3. Lots determined as: Composite SL / Risk Amount

Percent of Account
Balance

The lots for new position is calculated based on

• Balance available on account, and
• Position Risk Percent, and
• BUY/SELL Gap Size, and
• Max Open Ticket Count

The lots for the new position is calculated the following way:

 1. Composite SL is determined as: BUY/SELL Gap Size x Max Open Ticket Count
 2. Risk amount is determined as: Position Risk Percent of Account Balance
 3. Lots determined as: Composite SL / Risk Amount

Manual Lot Size The lots for the new position is not calculated by the EA, instead it is fixed and set to the
user-defined value from BUY/SELL Lots for 'Manual Lot Size'.

The position sizing calculation takes place at the time of market entry, when all the entry criteria are met.
 Position Risk Percent

Position Risk Percent

Determines the risk amount allocated to a new grid level trade as a percent of the broker account value. For more
details see the Position Sizing Method.
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4.2.3 BUY/SELL Grid Settings

 BUY/SELL Grid Trading Allowed

BUY/SELL Grid Trading Allowed

Turns on or off the trade of the grid in the BUY or SELL direction.
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 BUY/SELL Initial Entry Price

BUY/SELL Initial Entry Price

When the EA is started off when no open grid trades are on the account, the EA enters the very first grid trade
only when the actual market price reaches this initial entry price. For any subsequent grid trade, for the current
grid or starting a new grid after a closure, or when the account already has open grid trades when the EA is started
off, this initial entry price has no effect, does not cause the EA to wait with trades.

 BUY/SELL Lots for 'Manual Lot Size'

BUY/SELL Lots for 'Manual Lot Size'

Sets the lot size for new positions to this user-defined value when the Manual Lot Size option is selected for
Position Sizing Method.

 BUY/SELL Gap Size

BUY/SELL Gap Size

Defines the gap between grid levels in pips. The BUY/SELL Gap Size value should be minimum of 10 pips or
more, and no fractional pips should be entered. To avoid confusion the BUY/SELL Gap Size must always be at
least twice of the Level Sensitivity value, or more.

 BUY/SELL Stop Loss

BUY/SELL Stop Loss

Stop loss in pips for new buy or sell orders. No fractional pip value to be entered, e.g. for 200 pips stop loss this
parameter value should be set to 200 regardless of 4 or 5-digit broker feed. Value 0 (zero) turns off stop loss for
new orders.

Note:  This BUY/SELL Stop Loss facility is provided for safety purposes. Should the connection to the broker go
down, or during power outage the server side can have this stop loss set up to limit potential losses until normal
EA operation resumes.

 BUY/SELL Take Profit

BUY/SELL Take Profit

Take profit in pips for new buy or sell orders. No fractional pip value to be entered, e.g. for 200 pips take profit
this parameter value should be set to 200 regardless of 4 or 5-digit broker feed. Value 0 (zero) turns off the take
profit for new orders.

When this BUY/SELL Take Profit is configured with higher than zero value, the entered trade is going to get
closed off at the configured take profit pips distance, instead of the next grid level. This means that all the trade
entries are executed at the grid levels as per grid gap size (observing the potential grid gap scaling), however the
exit of the open trades are triggered only when they reach their BUY/SELL Take Profit pips target.

 BUY/SELL Counter-Trend Scaling
 BUY/SELL Counter-Trend Scaling After Grid Level
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BUY/SELL Counter-Trend Scaling After Grid Level

When market price goes against the direction of the grid trades the BUY/SELL Gap Size and the lots for new
entries are scaled by the EA for levels specified by the BUY/SELL Counter-Trend Scaling After Grid Level
value. Value zero (0) turns off the scaling feature of the EA, and the scaling can start from level 2 or beyond.

Note:  The lot scaling is applied to both the Manual Lot Size and the Percent of Account ... lot sizing options. See
Position Sizing.

See examples at BUY/SELL Counter-Trend Gap Scaling Percent and BUY/SELL Counter-Trend Lot Scaling
Down Percent.

 BUY/SELL Counter-Trend Gap Scaling Percent

BUY/SELL Counter-Trend Gap Scaling Percent

When market price goes against the direction of the grid trades the BUY/SELL Gap Size is scaled up by BUY/
SELL Counter-Trend Gap Scaling Percent factor for levels specified by the BUY/SELL Counter-Trend Scaling
After Grid Level value.

Below shows the gaps to be used for a BUY grid trading direction when

• BUY Gap Size is set to 80 pips
• BUY Counter-Trend Scaling After Grid Level is set to 2
• BUY Counter-Trend Gap Scaling Percent is set to 50%

Grid Level Effective Gap Pips

Up 4 80

Up 3 80

Up 2 80

Up 1 80

Start 80

Down 1 80

Down 2 80

Down 3 120

Down 4 180

Down 5 270

 BUY/SELL Counter-Trend Lot Scaling Down Percent

BUY/SELL Counter-Trend Lot Scaling Down Percent

When market price goes against the direction of the grid trades the effective lot size for new entries is scaled
down by BUY/SELL Counter-Trend Lot Scaling Down Percent factor for levels specified by the BUY/SELL
Counter-Trend Scaling After Grid Level value.

Note:  The lot scaling is applied to both the Manual Lot Size and the Percent of Account ... lot sizing options. See
Position Sizing.

Below shows the lots to be used for a BUY grid trading direction when

• BUY Lots for 'Manual Lot Size' is set to 0.10 lots
• BUY Counter-Trend Scaling After Grid Level is set to 2
• BUY Counter-Trend Lot Scaling Down Percent is set to 50%

Grid Level Lots Entered

Up 4 0.10

Up 3 0.10

Up 2 0.10

Up 1 0.10

Start 0.10
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Grid Level Lots Entered

Down 1 0.10

Down 2 0.10

Down 3 0.05

Down 4 0.03

Down 5 0.01

 BUY/SELL Trading Boundary
 BUY/SELL No New Buy/Sell On or Below Price

BUY/SELL No New Buy/Sell On or Below Price

The minimum price limit to enter new grid trades. When the actual price approaches or goes below this level
the EA does not open new trades at the corresponding grid levels. Once the actual price reverses back above this
minimum price limit the EA resumes opening new grid trades as per the normal grid trading rules.

Examples:

• BUY No New Buy On or Below Price is set to 0

There is no lower price limit to the buy grid trades, i.e. this feature is turned off for the BUY side.

Important:  The SELL side has its own EA parameter to control the boundary of the sell grid, independent
from the BUY side.

• SELL No New Sell On or Below Price is set to 1.2345

The EA trades sell grid until the next sell entry level approaches, or is below, the 1.2345 value. When the
1.2345 is approached the EA no longer enters new sell grid trades. Should the actual next sell entry level go
back above the 1.2345 then the EA resumes entering new sell grid trades.

Important:  The BUY side has its own EA parameter to control the boundary of the buy grid, independent
from the SELL side.

 BUY/SELL No New Buy/Sell On or Above Price

BUY/SELL No New Buy/Sell On or Above Price

The maximum price limit to enter new grid trades. When the actual price approaches or goes above this level
the EA does not open new trades at the corresponding grid levels. Once the actual price reverses back below this
maximum price limit the EA resumes opening new grid trades as per the normal grid trading rules.

Examples:

• SELL No New Sell On or Above Price is set to 0

There is no upper price limit to the sell grid trades, i.e. this feature is turned off.

Important:  The BUY side has its own EA parameter to control the boundary of the buy grid, independent
from the SELL side.

• BUY No New Buy On or Above Price is set to 1.2345

The EA trades buy grid until the next buy entry level approaches, or is above, the 1.2345 value. When the
1.2345 is approached the EA no longer enters new buy grid trades. Should the actual next buy entry level
go back below the 1.2345 then the EA resumes entering new buy grid trades.

Important:  The SELL side has its own EA parameter to control the boundary of the sell grid, independent
from the BUY side.

 Automatic vs Manual Sell Settings

Automatic vs Manual Sell Settings

If sell grid settings should be the same as already configured for buy leg then set this to Automatic vs Manual
Sell Settings. If the sell grid would have different settings compared to the buy grid then set this to Manual Sell
Settings and use the subsequent SELL xxxxx parameters to configure the sell grid.
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4.2.4 Operations Settings

 Reentry After Grid Closure

Reentry After Grid Closure

The EA performs the buy and sell grid trades until either the combined profit target or maximum losses reached.
Upon that the EA closes off all ongoing trades. A new grid trading cycle is started off only if this Reentry After
Grid Closure parameter is set to true.

 Max Open Ticket Count
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Max Open Ticket Count

Limits the maximum number of open buy and sell trades together. When the total number of open buy plus sell
trades reaches this limit then the EA does not enter new trades, neither buy or sell. When the total number of open
buy plus sell trades drops below this limit then the EA resumes entering new trades.

 Max Spread to Allow Trade

Max Spread to Allow Trade

During market periods when the spread goes up beyond this Max Spread to Allow Trade value the EA stops
trading activity, i.e. no new order is submitted nor existing order gets closed off. When spread falls below the
Max Spread to Allow Trade value the EA resumes trading operations as normal.

 Level Sensitivity

Level Sensitivity

Allocates a pip range at the grid levels the price action must fall within to trigger order management actions. If
the price crosses the grid level and falls within this range beyond the level then the EA will close off appropriate
open tickets and open new tickets for the level. However if the price crosses the grid level and jumps over the
range (e.g. price gapping at news announcements) then the EA will suppress any level specific order actions. This
is to avoid unwanted effects of quick price movements that would put the integrity of the grid at risk. Next time
when the price crosses the grid level “appropriately” the order management actions will be performed.

 Lot Adjustment for FIFO

Lot Adjustment for FIFO

Activates a FIFO specific operation mode of the trade position sizing. The FIFO adjustment requires the use of
manual lot sizing - see Position Sizing.

Lot Adjustment for FIFO Description

Normal Position Sizing No FIFO specific lot adjustment takes place. New trade's lot sizing is determined
by the Position Sizing.

Apply FIFO Adjustments When the market price goes against the existing grid trade, i.e. during pullback, the
EA alternates the lot size for the new trades around the configured manual lot size.
This will results in a sequence of trades with lot sizes like 0.09, 0.11, 0.08, 0.12
etc based on a starting manual lot size of 0.10. This varying lot sizes will allow the
closure of these trades in reversed order when the pullback turns around.

Note:  The FIFO Adjustments requires the Manual Lot Size option to be selected
for the Position Sizing.

The minimum lot size stepping allowed by the broker is used for the purpose of
FIFO adjustments. Some brokers and markets allow for as small as 0.01 lot size
stepping, but some only allows for 0.10 or even 1.00 lot stepping. The Manual Lot
Size should always be above the broker required minimum lot size plus a couple of
times the minimum lot size stepping.

Important:  The FIFO adjustments will require the increase of the lot sizes
used for the grid trades. The increased lot sizes result in higher account funding
requirements, higher margin requirements and overall higher risks. Please ensure
that your trading plan stays within your risk profile and is supported by your broker
account funding levels at all times.
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Examples:

 1. Lot Adjustment for FIFO is set to Normal Position Sizing

No FIFO specific lot adjustments take place. The lot for new grid trades is determined by the settings at
Position Sizing.

 2. Lot Adjustment for FIFO is set to Apply FIFO Adjustments

• Position Sizing is set to Manual Lot Size (mandatory)
• Assuming a broker market with minimum lot size of 0.01 and stepping 0.01, catering for up to 18

counter-trend grid levels during price pullback.
• BUY/SELL Lots for 'Manual Lot Size' is set to 0.10

The grid trades in the BUY direction get the following lot size allocations:

Grid Level Lots Entered

Up 1 Cash in & restart of grid.

Start 0.10

Down 1 0.09

Down 2 0.11

Down 3 0.08

Down 4 0.12

Down 5 0.07

Down 6 0.13

Down 7 0.06

Down 8 0.14

Down 9 0.05

Down 10 0.15

Down 11 0.04

Down 12 0.16

Down 13 0.03

Down 14 0.17

Down 15 0.02

Down 16 0.18

Down 17 0.01

Down 18 0.19

Down 19 and beyond No position entered.
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 Visual Grid Feedback on Chart

 Grid Levels Shown Above/Below Active Grid

Grid Levels Shown Above/Below Active Grid

The number of grid levels to be displayed on the chart above and below the current active grid levels. Controls
how many grid levels get visualized on the chart marking future trade activities.

 BUY/SELL Grid On-Chart Colour Scheme

BUY/SELL Grid On-Chart Colour Scheme

Offers various grid level visualization profiles on the chart in terms of colours to be used for grid levels. Value
zero (0) turns off grid visualization on the chart, other value in the range of 1 to 7 provides different colour
scheme for the grid levels.

 Grid Close Above Level Colour

Grid Close Above Level Colour

The colour of the horizontal line on the chart marking the upper limit for grid trades if configured at Close Grid
On or Above Price parameter.

 Grid Close Below Level Colour
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Grid Close Below Level Colour

The colour of the horizontal line on the chart marking the lower limit for grid trades if configured at Close Grid
On or Below Price parameter.

 No New BUY/SELL Below Level Colour

No New BUY/SELL Below Level Colour

The colour of the horizontal line on the chart marking the lower limit for BUY grid trades if configured at No
New Buy On or Below Price parameter.

 No New BUY/SELL Above Level Colour

No New BUY/SELL Above Level Colour

The colour of the horizontal line on the chart marking the upper limit for SELL grid trades if configured at No
New Sell On or Above Price parameter.

 Grid Closeout Summary Text Colour

Grid Closeout Summary Text Colour

The colour of the text on the chart describing in a single line summary of the grid closure. The grid gets closed off
when one of the exit conditions configured at the section Combined Profit & Risk Settings gets fulfilled.

 Planning Mode Visual Feedback

Planning Mode Visual Feedback

Selects the colours for the various graphical elements presented by the Forecast Tool in the chart.

Planning Mode Visual
Feedback

Description

Future Target Price
Colour

The colour of the price marker for the planned grid closeout. Drag&Drop this
marker in the chart to highlight the planned closeout price for the grid.

Initial Entry Price Colour The colour of the price marker for the planned grid start. Drag&Drop this marker in
the chart to highlight the planned entry price for the new grid.

Realized Existing Trade
Colour

Colour represents trades which are already open as part of the ongoing grid, and get
closed before the planned closeout at the future price.

Open Existing Trade
Colour

Colour represents trades which are already open as part of the ongoing grid, and
remain open by the planned closeout at the future price.
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Planning Mode Visual
Feedback

Description

Realized Future Trade
Colour

Colour represents trades to be entered and also closed off as price moves to the
planned closeout at the future price.

Open Future Trade Colour Colour represents trades to be entered but remaining open as price moves to the
planned closeout at the future price.

 Tick Scaling for CFD Markets

Tick Scaling for CFD Markets

Provides a consistent tick, pip, cent and point values across various markets and brokers. This is specific to stock
indices, metal, commodity etc markets keeping the cent or dollar unit consistently applied. Wherever the EA
is configured with a 'Pip' value then it is consistently mapped to the cent or dollar unit for those non-FOREX
markets.

Tick Scaling for CFD
Markets

Description

Auto Scale for Index
Markets

Based on the characteristics of the market the EA automatically recognizes if the
underlying market was a stock index market, like the US30, GER30 or JP225 etc.
In this case the 'pip' values configured for the EA are scaled up to the 'dollar' value
of the index: 12345.67

Never Scale The EA does not scale up the 'pip' values even if the market could be recognized as
a stock index market.

Always Scale The EA applies the scaling up of the 'pip' values to the 'dollar' value even if the
market could not be recognized as stock index market. This option is useful if the
'dollar' based approach is desired for trading.

Note:  The EA always deals with the fractional pip values therefore there is no need to increase the 'pip' values
for brokers with 1, 3 or 5-digit data feed.

Examples:

Trading
Approach

Chart of
Market

Stop Loss EA
Parameter
Value

Tick Scaling
for CFD
Markets
Value

Buy Entry Fill
Price

Calculated
Stop Loss
Value

Description

Index market
with $1.00
unit

US30 100 Auto Scale
for Index
Markets

Alternative:
Always Scale

26123.90 26023.90 The EA scales
the 100 'pips'
parameter to
market price
of 100.00 US
dollar units
(i.e. 100.00
points)
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Trading
Approach

Chart of
Market

Stop Loss EA
Parameter
Value

Tick Scaling
for CFD
Markets
Value

Buy Entry Fill
Price

Calculated
Stop Loss
Value

Description

FOREX pair
with 0.0001
unit

EURUSD 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

1.13412 1.12412 The EA keeps
the 100 'pips'
parameter as
it is

Gold market
with $0.01
unit

XAUUSD 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

1288.23 1287.23 The EA maps
the 100 'pips'
parameter to
100 cent units

Gold market
with $1.00
unit

XAUUSD 100 Always Scale 1288.23 1188.23 The EA maps
the 100 'pips'
parameter to
100 dollar
units

Oil market
with $0.01
unit

USOil 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

56.752 55.752 The EA maps
the 100 'pips'
parameter to
100 cent units

Oil market
with $1.00
unit

USOil 10 Always Scale 56.752 46.752 The EA maps
the 10 'pips'
parameter to
10 dollar units

Copper
market with
$0.01 unit

COPPER 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

2.9245 1.9245 The EA maps
the 100 'pips'
parameter to
100 cent units

Cocoa market
with $0.01
unit

COCOA 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

2160 2060 The EA maps
the 100 'pips'
parameter to
100 cent units

Natural gas
market with
$0.01 unit

NGAS 100 Auto Scale
for Index
Markets

Alternative:
Never Scale

2.843 1.843 The EA maps
the 100 'pips'
parameter to
100 cent units

 Magic Number Parameter
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Magic Number

The EA marks its orders with this value when submitting to the broker account, and picks up orders which are
marked with this magic number value and belong to the chart of the EA. In the case of multiple EA's running on
the same market ensure that they get unique Magic Number allocations to avoid cross-impact between the EA
instances handling the orders. See Configuration and Operation Principles section for more explanation and setup
examples.

Related information
Configuration and Operation Principles
The GridTrendMultiplier EA operational overview.
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Chapter

5
 Knowledgebase

5.1 How to Download MT5

Question

How can I install the MT5 platform?

Answer

Please download the MT5 setup application directly from one of your preferred brokers web site, or from
MetaQuotes website.

5.2 How to Download the Setup Application

Question

How to download the GridTrendMultiplier EA Setup application?

1. Log in to the Web Support Centre.

2. Scroll down and click on the GridTrendMultiplier EA in the Product List.

https://www.metatrader5.com/en/download
https://my.eafactory.com/
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3. Click on the Product Download button to download the EA setup.

5.3 How to Install the GridTrendMultiplier EA
The GTM EA comes with a setup application to provide a wizard based installation process to the selected MT5
terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT5 terminal version 5.00 build 2530 or later installed.

1. Exit MT5 if it was running.

2. Select the desired service and download the setup application with the latest version.

3. Run the setup application. Select the MT5 instance during setup to where you want the service installed.

4. When setup completes start up MT5. The GTM EA entry should appear under the Expert Advisors node in
the Navigator window (View > Navigator)

These pictures highlight the steps how to install the ea.
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The setup application lists the available MT5 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT5 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.

C:\Program Files\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader installation. As a hint, the following
shows you the default path to the main MT5 directory for some brokers:

Broker Default Path

Blueberry Markets broker C:\Program Files\Blueberry Markets MT5 Terminal

ICMarkets broker C:\Program Files\ICMarkets - MetaTrader 5

ActivTrades broker C:\Program Files\MetaTrader 5 - ActivTrades

Admiral Markets broker C:\Program Files\Admiral Markets MT5

Pepperstone broker C:\Program Files\Pepperstone MetaTrader 5

Always select the main MT5 folder itself for installation target, not any of its sub-directories.
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When the installation is complete, start up MT5 and check that the ea appears in the Navigator window (View >
Navigator):

So everything is set up for the first activation of the GridTrendMultiplier Expert Advisor  .

5.4 How to Upgrade the EA

Question

How to upgrade the GridTrendMultiplier EA?

Answer

In order to upgrade the EA please follow these steps:

 1. Download the latest GridTrendMultiplier EA from the Web Support Centre. For detailed steps refer to the
How to Download the Setup Application.

https://my.eafactory.com/
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 2. Exit the MT5 terminal if it was running.
 3. Execute the downloaded GridTrendMultiplier EA setup application. Follow through all of the wizard pages

to complete the EA installation.
 4. Start up the MT5 terminal.

The upgraded GridTrendMultiplier EA will pick up and carry on managing any existing trades created by the
previous EA version.

Related tasks
Step-by-step Installation of Expert4x EAs and Indicators

How to download an EA setup in VPS environment

Related information
How to Download the Setup Application

5.5 How to Attach the GridTrendMultiplier Expert Advisor  to a Chart
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the GridTrendMultiplier Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the GridTrendMultiplier Expert Advisor  from the Navigator window (View > Navigator)
to a chart window. In the appearing properties window select the Dependencies tab and tick the checkbox
Allow DLL imports:

2. Go to the Common tab and tick the checkbox Allow Algo Trading:
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Note:

Ensure that the

• Allow DLL imports and
• Allow Automated Trading

are ticked otherwise the GridTrendMultiplier EA is not able to start up.

3. Select the Inputs tab:

This lists the parameters of the EA where the operational aspect of the GridTrendMultiplier EA can be
set up. For more details see the GridTrendMultiplier EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.
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Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The GridTrendMultiplier EA is up and running

After successful authentication the GridTrendMultiplier EA starts up.

https://my.eafactory.com/expert4x
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The GridTrendMultiplier Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the GridTrendMultiplier Expert Advisor  was successful and the EA is now
looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the ea up and running please refer to the Knowledgebase section.

5.6 Buy or Sell Only Mode Grid

Question

How can I configure the GridTrendMultiplier EA to run in Buy only or Sell only mode? I.e. trading in one
direction only.
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In buy only mode the GridTrendMultiplier EA enters only buy grid trades, in sell only mode the
GridTrendMultiplier EA enters only sell grid trades.

BUY only mode

Set the following three EA parameters as highlighted below for BUY only mode.

1. Turn ON buy direction

Set the BUY Grid Trading Allowed parameter to Enabled

2. Turn OFF sell direction

Set the Automatic vs Manual Sell Settings parameter to Manual Sell Settings: Fill in SELL... Fields
Below

Set the SELL Grid Trading Allowed parameter to Disabled

SELL only mode

Set the following three EA parameters as highlighted below for SELL only mode.

1. Turn OFF buy direction

Set the BUY Grid Trading Allowed parameter to Disabled
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2. Turn ON sell direction

Set the Automatic vs Manual Sell Settings parameter to Manual Sell Settings: Fill in SELL... Fields
Below

Set the SELL Grid Trading Allowed parameter to Enabled

5.7 GridTrendMultiplier Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the GridTrendMultiplier Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the GridTrendMultiplier Expert Advisor  from the Navigator window (View > Navigator)
to a chart window. In the appearing properties window select the Dependencies tab and tick the checkbox
Allow DLL imports:
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2. Go to the Common tab and tick the checkbox Allow Algo Trading:

Note:

Ensure that the

• Allow DLL imports and
• Allow Automated Trading

are ticked otherwise the GridTrendMultiplier EA is not able to start up.

3. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the GridTrendMultiplier EA can be
set up. For more details see the GridTrendMultiplier EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The GridTrendMultiplier EA is up and running

After successful authentication the GridTrendMultiplier EA starts up.

https://my.eafactory.com/expert4x
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The GridTrendMultiplier Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the GridTrendMultiplier Expert Advisor  was successful and the EA is now
looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the ea up and running please refer to the Knowledgebase section.

5.8  Sign Instead of  Sign After Attach

Issue

After attaching to chart the EA is not managing trades, a  sign appears in the top right corner of the chart.
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EA's common and dependencies parameters might be not enabled

The Allow Automated Trading and Allow DLL imports might be not enabled

• Press F7 key and verify that the Allow Automated Trading and Allow DLL imports are checked in the
EA property dialog.

Algo Trading is disabled

The Algo Trading might be disabled

• Verify that the toolbar button Algo Trading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:
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5.9 EA Is Not Starting Up After Attach to Chart

Issue

The EA reports successful initialisation and advises about disabled Expert Advisors.

Algo Trading is disabled

The Algo Trading might be disabled

• Verify that the toolbar button Algo Trading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:

5.10 No Updates to Chart

Issue

The GridTrendMultiplier EA does not update information on the chart for several minutes.

Connection Lost

MetaTrader should be connected to the broker's server.

1. Check the bottom right corner of MetaTrader, this is when it has lost connection to the server:

2. If connection is lost then login again or restart MT to force reconnection. Try again activating the
GridTrendMultiplier EA when connection is back.

Demo account is expired

MT5 will not be able to connect to the demo account if it's expired. In this case MT5 will keep asking for the
login details and fail all login attempt.

• When this happens open a new demo account (right click Accounts in Navigator window and select Open
an Account).



Knowledgebase

Page 49

Market is closed

New tick information and updates to chart happens when markets are open.

• Double check that markets are meant to be open currently.

Disk is full

There should be at least 50MB free disk space available on the drive MetaTrader is installed on.

• If the free disk space is low then free up space.

5.11 Prompted for Access ID at Service Access Settings

Issue

After attaching to chart the GridTrendMultiplier EA asks for my Access ID in the Service Access Settings
window.

Type in your Access ID

The GridTrendMultiplier EA checks that the usage of product is appropriately licensed. After product purchase a
user profile is created on our web support site and the product can be downloaded from that web site. The support
site allows to set up an Access ID which is required by the GridTrendMultiplier EA to validate the product
licence. By default this Access ID is configured to be the same as your selected login name to the web support
site.

• When prompted, please enter your Access ID to the window and click Save:

Please do not share out to others your Access ID. That is against the licence agreement terms and
conditions and also all 3rd party usages will count when checking the number of ea copies being used.
Sharing out your Access ID can result in licence check failure and the ea may stop functioning.
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Keep your Access ID secure, change it away from the its default value at any time on the Web Support
Centre site.

5.12 How to Edit the EA Input Values

Question

How can I edit or change the settings of the GridTrendMultiplier EA once it is attached to a chart?

Answer

In order to edit the input parameters of an EA which is already attached to a chart follow these steps

1. Select/click the chart which hosts the GridTrendMultiplier EA in your MT5 application.

2.
Press F7 on your keyboard, or alternatively double click on the  (or  ) icon in the top-right corner of
the chart.

3. Edit the GridTrendMultiplier EA input values in the appearing EA properties window

4. Click OK when editing is complete

5.13 Not Enough Memory For Bar History Or Indicator

Issue

Some of the market bar history data or an indicator fails to load because the MT5 runs out of memory. An error
message similar to the below is reported:

Solution

The bar history data takes up too much memory when loaded into RAM and the charts. The MT5 application
needs to be configured to keep less number of bars on the charts.

1. In the MT5 application menu select Tools > Options then select the Charts tab.

2. Enter 65000 into the edit box Max bars in chart:

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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3. Attach the EA to the chart now. If the issue is still there then go back to the previous step and enter half of
the previous values. Keep repeating these two steps - halving the values every time - until the EA attaches
successfully.

5.14 No Trades Due to Trade Disabled

Issue

The GTM EA was attached to a chart, the EA is up and running. It keeps submitting market orders to the broker
server. However, the broker's server does not execute these market orders, instead, the broker says the trade on
this broker account is disabled:

The broker server reports the MT5 error code 133, which means that the trade is disabled on the account. This
is not an EA issue, instead, this is an issue with the broker account. For some reason the broker account does not
allow you to trade that market.

Solution

 1. Restart MT5 terminal (quit and start up) to see if the restart and reconnect to the broker resolves this.
 2. Identify another name for the same pair (maybe with some extra suffix in the market name, like

EURUSDecn) which is enabled for trading: attach the EA to another market.
 3. Logging into your MT5 broker account with the investor login credentials disables trading. Ensure that you

log in to your broker account with the full trader login credentials.
 4. Create another demo account with the broker.
 5. Contact your broker and ask for their support to enable trading on the pair or account

 1. Your broker account may have reached some trade limits (e.g. overall maximum lots).
 2. Your broker may have put (temporarily) trading limitations on your account for some reason.
 3. Your broker may have to enable trading by EAs.

5.15 Backtest In Visual Mode Not Working
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Issue

In the Strategy Tester using the visual mode DLL imports not allowed message appears on the chart. No result
after the Strategy Tester finished its run.

Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT5 for terminal global parameters to run the
GridTrendMultiplier EA in the backtest environment.

1. Open the MT5 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisors tab

3. Check the Allow DLL import

4. Restart the MT5: exit the MT5 application, wait 5 seconds then start it up again.

5.16 Backtest Not Working

Issue

After the backtest finished no result showing.
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Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT5 for terminal global parameters to run the
GridTrendMultiplier EA in the backtest environment.

1. Open the MT5 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisors tab

3. Check the Allow DLL import

4. Restart the MT5: exit the MT5 application, wait 5 seconds then start it up again.

5.17 Backtest - MT5 no history data error messages

Issue

After the backtest finished no result showing.

Error message: The message is : ERROR 1101 Start - past exception - MT5 no history data

Solution

The bar history database could be in inconsistent state. Try to run the backtest in visual mode, and start with
a recent and short calendar period, say for this week. If that works then you may want to expand the calendar
period, say to the last two weeks. In iterations then you could expand the calendar period until you hit the first
issue of the bar history.

Use the MT5 Strategy Tester controls highlighted to run the visual backtest over a calendar period:
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5.18 No Trades During Backtesting

Issue

After the backtest finished no trades are showing.

If you see no trades during backtesting then usually it is down to EA settings issue.

Run a Backtest in Visual Mode

In order to see any settings issue with the the GridTrendMultiplier EA I would suggest to run a backtest in Visual
mode. This would give a chance to see the EA dashboard and any error message in it.

Go to the MT5 Strategy Tester window and tick the Visual mode box:

Tip:  In the event of no Visual mode box is visible then follow the steps in the Visual Mode Checkbox Missing
in Strategy Tester topic.

Now run the backtesting in visual mode: click on the Start button. The Visual mode would make visible any
potential EA messages in the backtesting chart, giving hints for next steps.

Watch out for any red messages in the chart area.

You may find these knowledge based topics useful to resolve them:

• Backtest In Visual Mode Not Working, and
• Backtest Not Working

5.19 Visual Mode Checkbox Missing in Strategy Tester

Issue

Visual mode checkbox is missing in the Strategy Tester.
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Solution

The Strategy Tester window hides some control elements when the window itself is not tall enough, i.e. the
Optimization dropdown and the visual mode checkbox could become hidden.

Scroll down the Strategy Tester window to make visible the Optimization dropdown and the visual mode
checkbox controls:

1.

2.

3.

4.
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5.

5.20 Step-by-step Installation of Expert4x EAs and Indicators
In this tutorial the name of MetaTrader is used as an example. Replace the MetaTrader with your broker specific
MetaTrader name.

1. Start your MT5 terminal and select the File > Open Data Folder menu

The menu opens a File Explorer.

2. Close your MT5

3. Check the File Explorer

• If the File Explorer shows a folder like this one below
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and you see the origin.txt or the origin file go to the standard installation page.
• If the File Explorer shows a folder like this one below

and you see the terminal.exe or terminal file go to the non-standard installation page.

5.20.1 Standard EA, Indicator installation
In the opened File Explorer the origin.txt or the origin file was found.

Please follow through the steps below to install the Expert4x EA or Indicator on your MT5

1. Double click the origin.txt file and take a note of the MetaTrader location.

2. Start the EA or indicator setup program. Follow through the setup until you reach the Select Target
MetaTrader Directory window.
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3. In this window select your targeted MetaTrader's Data Folder, as per the origin.txt noted earlier, and click
Next

4. Follow through the rest of the setup application.

5. In the end click Install

6. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an EA or the Indicators

section if you installed an Indicator and look for the EA or Indicator.

5.20.2 Non-standard EA, Indicator installation
In the opened File Explorer the terminal.exe or terminal file was found.

Please follow through the steps below to install the an Expert4x EA or Indicator on your MT5

1. Right click on the name of the Setup application

2. Select Run as administrator (You may get a few security warning or you may need to type in the
Windows administrator password)
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3. Follow through the application until you reach the Select Target MetaTrader Directory window.

4. Click Add target directory... button

5. Navigate to your MetaTrader folder
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and click OK.

6. Scroll down to the end of the list. Select the target directory. Click Next.

7. Follow through the rest of the setup application.

8. In the end click Install
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9. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an EA or the Indicators

section if you installed an Indicator and look for the EA or Indicator.

5.21 How to download an EA setup in VPS environment
In this topic we guide you through the EA setup application download in VPS environment.

1. Start the File Explorer

Click the File Explorer

The File Explorer started.
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2. Select the address bar section

3. Type in: https://my.eafactory.com/expert4x and press Enter to start the Internet Explorer

Did you get blank screen? As you see below:

https://my.eafactory.com/expert4x
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If yes, please select the address bar in the Internet Explorer and type in: https://my.eafactory.com/
UserInterface/index.zul?p=1

If you got this message below you may need to adjust temporary your Internet security settings.

4. When the Web support Site is appeared please log in

5. Select the EA name from the Product List and click Product Download in the Release List

https://my.eafactory.com/UserInterface/index.zul?p=1
https://my.eafactory.com/UserInterface/index.zul?p=1
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If you got this message below you may need to adjust temporary your Internet security settings to enable
downloads.

Warning messages related to the download

• Do you want to save GridTrendMultiplier EA_v4.11.0_Setup.exe ...?

Click Save to resolve this warning
• If you use Internet Explorer 9.0 you may get this message:

GridTrendMultiplier EA_v4.11.0_Setup.exe is not commonly downloaded and could harm your
computer

This message is a new features in Internet Explorer 9.0. IE 9.0 has increased user security.

"When you download a program from the Internet, SmartScreen Filter will check the program
against a list of programs that are downloaded by a significant number of other Internet Explorer
users and a list of programs that are known to be unsafe. If the program you're downloading isn't on
either list, SmartScreen Filter will display a warning that the file isn't "commonly downloaded." It
doesn't necessarily mean the website is fraudulent or that the program is malware, but you probably
shouldn't download or install the program unless you trust the website and the publisher."

Source: http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-
questions-IE9?SignedIn=1

These are the steps if you'd like to continue installing the GridTrendMultiplier EA EA:

 1. Click the Action button in the displayed message
 2. In the dialog box click the down arrow to the left of More options, and click Run anyway

6. After the successful download the Internet Explorer may show this message

To start the installation process after the download click Run

7. Clean up after the download in the Internet Explorer

5.21.1 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message popped up.

http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
https://my.eafactory.com/expert4x
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JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level

https://my.eafactory.com/expert4x
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5. Scroll down until you see Scripting

6. Under the Active scripting select Enable

7. Click OK
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8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.21.2 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message popped
up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level
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5. Scroll down until you see Downloads

6. Under the File download select Enable

7. Click OK
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8. Click OK

9. click the Product Download button again

5.21.3 Clean up after the download in the Internet Explorer
In this topic we guide you through how to clean up after download in VPS environment.

1. In the Inter Explorer click Tools icon

2. Select Internet options
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3. Go to the Security tab

4. Click the Default level
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5. Click OK
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5.22 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message popped up.

JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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3. Go to the Security tab

4. Select Custom level

5. Scroll down until you see Scripting

6. Under the Active scripting select Enable

7. Click OK
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8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.23 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message popped
up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level
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5. Scroll down until you see Downloads

6. Under the File download select Enable

7. Click OK



8. Click OK

9. click the Product Download button again
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Chapter

6
 Operational Messages

The GridTrendMultiplier EA operational messages and resolution guide.

Code Severity Message Description

1001 Error Setup problem: DLL imports
not allowed. Tick Allow DLL
imports in Common tab of the
properties window.

Configuration setting is missing
to allow the ea to use dynamicaly
loaded libraries (DLLs). Enable
the load of DLLs and restart the
ea. More...

1002 Error Incomplete ea installation: Run
setup application for MT5
instance "<MT5DataPath>'s Data
Folder"

Product installation is not
complete or damaged. Run the
setup application for the MT5
terminal instance as displayed.
More...

1006 Error MT5 Expert Advisors are
disabled: click AutoTrading icon
on MT5 toolbar to execute the
EA.

EA does not perform its
operations, not monitoring nor
reacting to price movements of
the market. More...

1007 Error

Live trading is not allowed (
sign): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform

trading operations, there is a 
sign in the top right corner of the
chart. More...

1008 Error Authentication failed or
interrupted (<Stopped>,
<Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The ea is not able to authenticate
the user access to the service at its
start up time. More...

50001 Error 'Max Open Ticket Count' must
be 1 or higher for the selected
Position Sizing Method.

Automated position sizing
requires maximum ticket count to
be defined. More...

50002 Error Position sizing failed, too
small derived Stop Loss of
<DerivedStopLoss>.

Automated position sizing
derived stop loss is too small.
More...

50003 Error Current price <Bid> is already
on or above the configured limit
<GridCloseOnOrAbovePrice>.

Market price is outside the upper
limit allowed for grid trading.
More...

50004 Error Current price <Bid> is already
on or below the configured limit
<GridCloseOnOrBelowPrice>.

Market price is outside the lower
limit allowed for grid trading.
More...

50005 Error BUY entry <BuyEntryPrice> is
on or above the configured limit
<GridCloseOnOrAbovePrice>.

The configured buy entry price is
outside the upper limit allowed
for grid trading. More...

50006 Error BUY entry <BuyEntryPrice> is
on or below the configured limit
<GridCloseOnOrBelowPrice>.

The configured buy entry price is
outside the lower limit allowed
for grid trading. More...

50007 Error SELL entry <SellEntryPrice> is
on or above the configured limit
<GridCloseOnOrAbovePrice>.

The configured sell entry price is
outside the upper limit allowed
for grid trading. More...
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Code Severity Message Description

50008 Error SELL entry <SellEntryPrice> is
on or below the configured limit
<GridCloseOnOrBelowPrice>.

The configured sell entry price is
outside the lower limit allowed
for grid trading. More...

50110 Error Aborted by user due to lack
of trade history, EA is shut
down (<GridStartTicketSell>,
<GridStartTimeSell>,
<GridStartTicketBuy>,
<GridStartTimeBuy,
<LastMonthFound>).

User selected to stop EA due to
lack of trade history. More...

50112 Error Missing grid initial tickets
(Sell:<SellTicket>,
Buy:<BuyTicket>) on broker
account, EA is shut down. Press
F7 and click OK for more
instructions.

Initial grid start tickets are
no longer available on broker
account. More...

6.1 Message 1001

Code Severity Message Description

1001 Error Setup problem: DLL imports
not allowed. Tick Allow DLL
imports in Common tab of the
properties window.

Configuration setting is missing
to allow the ea to use dynamicaly
loaded libraries (DLLs). Enable
the load of DLLs and restart the
ea. More...

Setup problem: DLL imports not allowed

Issue

The ea is not able to start up when gets attached to a chart because some of its dependencies could not be loaded
into memory. The EA requires some dynamically loaded libraries (DLL) to be loaded into memory from disks.
When the ea configuration settings do not allow the load of DLLs then the ea cannot start up and reports this error
message.

Possible root cause

• The ea configuration does not allow for the load of DLLs.

Resolution

Enable the load of DLLs in the ea configuration dialog.

 1. Attach the ea to a chart, or if already attached then select the chart and

• In case of an EA: press F7
• In case of an indicator: press Ctrl+I and double-click the name of the indicator in the list.

 2. Go to the Dependencies tab of the Property window.
 3. Tick the checkbox Allow DLL imports.
 4. Click OK.
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6.2 Message 1002

Code Severity Message Description

1002 Error Incomplete ea installation: Run
setup application for MT5
instance "<MT5DataPath>'s Data
Folder"

Product installation is not
complete or damaged. Run the
setup application for the MT5
terminal instance as displayed.
More...

Incomplete Installation

Issue

The ea is not able to start up when gets attached to a chart because some of its dependencies could not be found
on the file system.

Possible root cause

• The ea setup application was not able to perform all its steps, not completed in full.
• The product was installed manually and some of the steps were missed.
• The MT5 instance's file system got damaged, some files got corrupted or deleted.

Resolution

Download the ea setup application and execute it to get the product installed for the MT5 instance:

 1. Download the setup application from Web Support Centre.
 2. Execute the setup application to get the product installed. For installation guide refer to any of the

following:

• Getting Started with the GridTrendMultiplier EA
• Step-by-step Installation of Expert4x EAs and Indicators

6.3 Message 1006

Code Severity Message Description

1006 Error MT5 Expert Advisors are
disabled: click AutoTrading icon
on MT5 toolbar to execute the
EA.

EA does not perform its
operations, not monitoring nor
reacting to price movements of
the market. More...

https://my.eafactory.com/expert4x
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EA AutoTrading Disabled

Issue

The EA is not responding to price movements, not performing its logic upon data ticks coming in from the
broker. The MT5 toolbar button AutoTrading is disabled.

Possible root cause

• The AutoTrading button on the MT5 toolbar is disabled.

Resolution

Press the AutoTrading button on the MT5 toolbar.

6.4 Message 1007

Code Severity Message Description

1007 Error

Live trading is not allowed (
sign): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform

trading operations, there is a 
sign in the top right corner of the
chart. More...

Live Trading Not Allowed

Issue

The EA is unable to perform trading operations, there is a  sign in the top right corner of the chart.

Possible root cause

• The Allow live trading checkbox is not ticked at the EA properties window.

Resolution

Enable live trading in the EA properties window.

 1. Go to the chart and press F7.
 2. Go to the Common tab of the Expert properties window.
 3. Tick the checkbox Allow live trading.
 4. Click OK
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6.5 Message 1008

Code Severity Message ToDo

1008 Error Authentication failed or
interrupted (<Stopped>,
<Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The ea is not able to authenticate
the user access to the service at its
start up time. More...

Failed Authentication

Issue

The ea is not able to authenticate the user access to the service at attach or restart time and does not start up.

Possible root cause

• The ea could not connect to the authentication server.
• The user quit the authentication process.
• There is a typo in the Access ID entered by the user.
• The GridTrendMultiplier EA is not yet purchased by the user.
• The GridTrendMultiplier EA was purchased, but not yet activated by the user.
• The GridTrendMultiplier EA was purchased or a trial started, but the licensed period (e.g. calendar days)

has lapsed.
• The GridTrendMultiplier EA was purchased, but the licensed usage limit (e.g. number of parallel accesses)

is breached by the user.

Resolution

Double check the following items to find resolution to the issue.

 1. Ensure that the computer has working Internet connection. For example, go to the Web Support Centre and
see if the page loads with no issues. When the Internet connection is working, restart the ea by pressing F7
and clicking the OK button of the Expert property window.

 2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save button of the
Service Access Settings authentication window.

https://my.eafactory.com/expert4x
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 3. Ensure you have purchased the product. Log in to the Web Support Centre and select the
GridTrendMultiplier EA from the product list. If the product is not available for download then it is yet to
be purchased at the Web Support Centre.

 4. Count the number of computers you are running the GridTrendMultiplier EA on. If it is more than what
the purchased ea licence copies allow then either shut down on the excess number of the computers all the
running GridTrendMultiplier instances, or purchase more licence at the Web Support Centre.

6.6 Message 50001

Code Severity Message Description

50001 Error 'Max Open Ticket Count' must
be 1 or higher for the selected
Position Sizing Method.

Automated position sizing
requires maximum ticket count to
be defined. More...

Maximum Open Ticket Count Too Low

Issue

The automated position sizing feature of the EA estimates the maximum loss based on the maximum number of
open tickets allowed for a grid and the gap size. However, the Max Open Ticket Count is set to zero.

Possible root cause

• The Position Sizing Method is set to one of the 'Percent of Account Margin/Equity/Balance' while the Max
Open Ticket Count is set to zero.

Resolution

Consider one of the following items to find resolution to the issue.

 1. Keep the selected Position Sizing Method as it is, and enter value 1 or higher to Max Open Ticket Count.
 2. Alternatively, select 'Manual Lot Size' for Position Sizing Method and enter the desired lot size to

BUY_Lots and SELL_Lots. In this case the automated position sizing is turned off and the manual lot sizing
is activated.

6.7 Message 50002

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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Code Severity Message Description

50002 Error Position sizing failed, too
small derived Stop Loss of
<DerivedStopLoss>.

Automated position sizing
derived stop loss is too small.
More...

Derived Stop Loss Too Small

Issue

The automated position sizing feature of the EA estimates the maximum loss based on the maximum number of
open tickets allowed for a grid and the gap size. However, either the Max Open Ticket Count or the BUY Gap
Size/SELL Gap Size is set to zero.

Possible root cause

• The Position Sizing Method is set to one of the 'Percent of Account Margin/Equity/Balance' while the Max
Open Ticket Count or BUY Gap Size/SELL Gap Size is set to zero.

Resolution

Consider one of the following items to find resolution to the issue.

 1. Keep the selected Position Sizing Method as it is, and enter value 1 or higher to Max Open Ticket Count,
BUY Gap Size and SELL Gap Size.

 2. Alternatively, select 'Manual Lot Size' for Position Sizing Method and enter the desired lot size to
BUY_Lots and SELL_Lots. In this case the automated position sizing is turned off and the manual lot sizing
is activated.

6.8 Message 50003

Code Severity Message Description

50003 Error Current price <Bid> is already
on or above the configured limit
<GridCloseOnOrAbovePrice>.

Market price is outside the upper
limit allowed for grid trading.
More...

Price Already On Or Above Limit

Issue

The EA does not start up because the market price is above the configured upper limit. This is to avoid flipping
between start up a new grid and close it off immediately because the market price is on or above the limit
triggering grid closure.

Possible root cause

• The current market price is already on or above the configured upper limit Close Grid On or Above Price.

Resolution

Adjust the value of Close Grid On or Above Price to be below the current market price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the Close Grid On or Above Price entry, press F2 and enter the new value.
 4. Click OK.

6.9 Message 50004
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Code Severity Message Description

50004 Error Current price <Bid> is already
on or below the configured limit
<GridCloseOnOrBelowPrice>.

Market price is outside the lower
limit allowed for grid trading.
More...

Price Already On Or Below Limit

Issue

The EA does not start up because the market price is below the configured lower limit. This is to avoid flipping
between start up a new grid and close it off immediately because the market price is on or below the limit
triggering grid closure.

Possible root cause

• The current market price is already on or below the configured lower limit Close Grid On or Below Price.

Resolution

Adjust the value of Close Grid On or Below Price to be above the current market price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the Close Grid On or Below Price entry, press F2 and enter the new value.
 4. Click OK.

6.10 Message 50005

Code Severity Message Description

50005 Error BUY entry <BuyEntryPrice> is
on or above the configured limit
<GridCloseOnOrAbovePrice>.

The configured buy entry price is
outside the upper limit allowed
for grid trading. More...

Buy Entry Price On Or Above Limit

Issue

The EA does not start up because the configured buy entry price is on or above the Close Grid On or Above
Price. This is to avoid flipping between start up a new grid and close it off immediately because the market price
will be on or above the limit triggering grid closure.

Possible root cause

• The configured buy entry price is on or above the configured upper limit Close Grid On or Above Price.

Resolution

Adjust the value of BUY Initial Entry Price to be below the Close Grid On or Above Price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the BUY Initial Entry Price entry, press F2 and enter the new value.
 4. Click OK.

6.11 Message 50006
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Code Severity Message Description

50006 Error BUY entry <BuyEntryPrice> is
on or below the configured limit
<GridCloseOnOrBelowPrice>.

The configured buy entry price is
outside the lower limit allowed
for grid trading. More...

Buy Entry Price On Or Below Limit

Issue

The EA does not start up because the configured buy entry price is on or below the Close Grid On or Below
Price. This is to avoid flipping between start up a new grid and close it off immediately because the market price
will be on or below the limit triggering grid closure.

Possible root cause

• The configured buy entry price is on or below the configured lower limit Close Grid On or Below Price.

Resolution

Adjust the value of BUY Initial Entry Price to be below the Close Grid On or Below Price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the BUY Initial Entry Price entry, press F2 and enter the new value.
 4. Click OK.

6.12 Message 50007

Code Severity Message Description

50007 Error SELL entry <SellEntryPrice> is
on or above the configured limit
<GridCloseOnOrAbovePrice>.

The configured sell entry price is
outside the upper limit allowed
for grid trading. More...

Sell Entry Price On Or Above Limit

Issue

The EA does not start up because the configured sell entry price is on or above the Close Grid On or Above Price.
This is to avoid flipping between start up a new grid and close it off immediately because the market price will be
on or above the limit triggering grid closure.

Possible root cause

• The configured sell entry price is on or above the configured upper limit Close Grid On or Above Price.

Resolution

Adjust the value of SELL Initial Entry Price to be below the Close Grid On or Above Price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the SELL Initial Entry Price entry, press F2 and enter the new value.
 4. Click OK.

6.13 Message 50008
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Code Severity Message Description

50008 Error SELL entry <SellEntryPrice> is
on or below the configured limit
<GridCloseOnOrBelowPrice>.

The configured sell entry price is
outside the lower limit allowed
for grid trading. More...

Sell Entry Price On Or Below Limit

Issue

The EA does not start up because the configured sell entry price is on or below the Close Grid On or Below
Price. This is to avoid flipping between start up a new grid and close it off immediately because the market price
will be on or below the limit triggering grid closure.

Possible root cause

• The configured sell entry price is on or below the configured lower limit Close Grid On or Below Price.

Resolution

Adjust the value of SELL Initial Entry Price to be below the Close Grid On or Below Price.

 1. Attach the EA to a chart; or if already attached then select the chart and press F7.
 2. Go to the Common tab of the Expert Property window.
 3. Select the SELL Initial Entry Price entry, press F2 and enter the new value.
 4. Click OK.

6.14 Message 50110

Code Severity Message Description

50110 Error Aborted by user due to lack
of trade history, EA is shut
down (<GridStartTicketSell>,
<GridStartTimeSell>,
<GridStartTicketBuy>,
<GridStartTimeBuy,
<LastMonthFound>).

User selected to stop EA due to
lack of trade history. More...

Stopped Due to Lack Of Trade History

Issue

The user selected to stop the EA because of potential trade history issue on the broker account. In the context
of this message the potential issue is that the MT4 terminal could be configured to download only the current
calendar month's trade history from the broker server. A potential future problem is that when grid is started in
this ongoing month and the calendar rolls over to the next month, the MT4 terminal may drop the trade history
upon the month rollover. If the trade history gets dropped then EA would no longer be able to track all grid trades
since the grid start and would need to stop, leaving the grid trades unmanaged.

Note:  The MT4 terminal, after its installation, downloads the trade history only for the current month. To avoid
the above potential issue it is highly recommended to enable the download of the full trade history as described
below.

See more details at Enable History During First Time Activation and Message 50112.

Possible root cause

• The MT4 is configured to download only the current month's trade history from the broker server.
• The broker account is brand new, freshly created, and there is no trade history at all on the broker account

Resolution

Consider the following items to find resolution to the issue.
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 1. Reconfigure the MT4 terminal to download full history of trades, i.e. have trades history not only for the
current month but for previous ones as well to allow long grid cycles being tracked by the EA. Follow the
steps described at Full Trade History Must Be Enabled.

 2. In the case of a brand new broker account simply ignore this warning at the start of the EA. Once the
history of trades builds up this warning message will no longer appear.

6.15 Message 50112

Code Severity Message Description

50112 Error Missing grid initial tickets
(Sell:<SellTicket>,
Buy:<BuyTicket>) on broker
account, EA is shut down. Press
F7 and click OK for more
instructions.

Initial grid start tickets are
no longer available on broker
account. More...

Grid Start Tickets No Longer Available

Issue

The EA cannot find the initial grid start tickets on the broker account and therefore halts. The EA requires access
to all grid related tickets on the broker account since the start of the grid in order to track the profit and loss status
of the grid and to manage the trades at the grid levels. When access to the tickets on the broker account is not
available the EA cannot operate and has to stop.

Possible root cause

• User switched to another broker account in the MT5 terminal while the EA was running. The EA will not
be able to find the grid tickets on the new broker account as those were created on the other broker account.

• The broker server keeps trade history only for a limited number of trades or for a limited calendar days
duration. When these limits are exceeded and the grid is still ongoing then the information to track the grid
trades gets lost.

Resolution

Consider one of the following items to find resolution to the issue.

 1. In the MT5 terminal switch back to the broker account the grid was started off.

Note:  Best practice is to dedicate an MT5 instance to a single broker account when any EA is active and
performing trading. This is to avoid confusion and any potential trading issues. If desired make multiple
installations of the MT5 terminal for other purposes.

 2. If, after enabling the full trade history, the EA is still not able to find the missing trades on the right broker
account then it could be a broker side limitation as of how much and for how long the trade history is kept
on the broker server. Talk to the broker to clarify their policy regarding availability of the trade history.
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7
 Support

Please contact support@eafactory.com if you require any further assistance. Please copy info@expert4x.com on
your email.

mailto:support@eafactory.com?cc=info@expert4x.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
mailto:info@expert4x.com?cc=support@eafactory.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
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